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Introduction

This manual describes briefly the use of MacBeads 1.01. Please read it before pitching in -

there are some things which might otherwise cause you some problems.

MacBeads 1s a program which enables the user to build 3D spatial models composed of
spherical beads. When a satisfactory model has been built, then a text file output can be
requested which gives the size, 3D coordinates and number of all the beads selected.
Relevant details of the total model (name, mass, partial specific volume) can also be stored in
the same file in a ‘tailpiece’ Alternatively, a model can be input from a suitably formatted
text file produced from crystallographic co-ordinates by a program such as AtoB (Olwyn
Byron). MacBEADS models can also be plotted and manipulated in 3D space (APPENDIX)

Basic Philosophy of MacBeads
MacBeads has two primary uses:

(1) given some sort of preliminary, low resolution model of a macromolecular structure,
MacBeads enables that structure to be mapped out in space as an assembly of
spherical beads. The low resolution model might, for example, derive from EM or
LAXS data. Programs such as HYDRO (Garcia de la Torre) can evaluate
hydrodynamic parameters (frictional coefficient, diffusion & sedimentation
coefficients, intrinsic viscosity) from such bead models. They require that the details
of the size and (x,y,z) locations of each bead be specified in a suitably formatted text
file. MacBeads produces text files containing this data for the model which has been

built by the user.

(i1) given an existing bead model, for example derived from crystallographic coordinates,
MacBeads provides a convenient way of ‘bending it around’” - i.e. making
adjustments to relative orientations of major domains, to probe the effect of so doing
on hydrodynamic parameters. An example of this can be seen in the work on the

flexibility of the myosin head in Bayliss et al (1999).

The present Manual concentrates on the first of these uses, as the principles of the use of the
program are identical in either case. A familiarity with the normal use of menus etc and with

simple graphics operations (e.g. dragging and marqueeing) within the Mac OS is assumed.



How models are built
The definition of a bead

A bead is a single spherical entity of defined radius with its center located at defined (X,y,z)
coordinates. Generally the user of MacBeads will have specified the radius such that the
molecular mass is defined via an experimentally known or computed partial specific volume
(vbar). This is done either from first principles or by making use of a general hydrodynamic
utility suite (e.g. BIOMOLS from the NCMH). Clearly if n beads are to be used to model a
particle (e.g. a protein domain) then the sum of the mass of the n beads should be equal to the

known mass of the particle.

Beads are created located and duplicated as needed via the Bead Menu (p. 5). Any individual

bead is selected by ‘clicking” on it, when a ‘handle’ appears within the bead:

The bead on the right hand end of this row of 3 1s the one selected. You can select more than
one bead either by ‘shift clicking” on the desired beads, or by marqueeing the same. You can
then deselect any given selected bead by ‘shift clicking” it. Note: a newly created bead 1s

always 1n ‘selected” mode.

You can OPEN any bead by double-clicking on same (or by selecting it and using the OPEN
BEAD function, p. 5). The bead is ‘greyed’ and a dialog box appears:

Bead Settings
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You can then modify the bead details as required. Note: you must exit from this dialog box
by clicking on either OK or Cancel or Close Dialog Boxes — not by clicking back onto any
other window ! {if you accidentally do that — re-open the bead and exit properly . . . }

You may also modify the size property (radius) of an individually selected bead by simply
getting hold of its handle and enlarging or reducing it by dragging.

The three coordinate planes

MacBeads display 3 windows which give the view of the assembly of beads which you have
created in the 3 coordinate planes (YZ, ZX, XY). You will be asked to specity the (z,y,z)
coordinates of each bead which you create. You can select which view you require either by

use of the View Menu (p. 6) or by simply clicking on the required window.
How beads are moved in space

You do not need to make a decision as to where a newly created bead should be finally
located at the time of its creation. You can, for example, create all beads at some reference
position, and then either drag them to the position desired, or use the translate function
available from the Transform Menu (p. 6). Dragging works fine of course with any given

selection of beads — or with your whole model, selected by marqueeing everything.
Working with built or part-built models

The ability to select either the whole or a part of a model (by marqueeing or by shift-
clicking) means that it 1s easy to manipulate the orientation of whatever is selected, whilst
leaving any unselected regions unchanged. Moreover, the four very useful functions
contained in the Transform Menu (p. 6) mean that one can opt to work on your model (or a
part of 1t) in any plane — not just the 3 principal planes — by simply rotating it in any desired

way until the plane to be worked on coincides with a principal plane.



The use of the Menus in MacBeads

The functionality provided by the various Menu functions are a central, powerful feature of

MacBeads. These are described below, in order (L to R) as they appear in the Menu Bar:
File

These are standard Apple File Menu functions — but note the Save as Text command which

enables you to save the output details of your model
Edit

-ﬁ File Iiﬂl Bead Transform VYiew Patterns

LUndo Drag 37

Cut X
0= copy =
: Paste Y |: : :
Clear
......... SetTailpiece..

This again resembles the standard Apple Menu — except that there is now a Set Tailpiece
option. You us this to enter the name etc of your model, and the details entered will appear in

your final output file.

Bead
& File Edit i Transform View Patterns
New Bead... H*K
Old Bead B
[Fi Open Bead... 2 s
| ; Close All Dialogs %D F—

This Menu enables you to create beads. New Bead creates a new bead, with a dialog box
enabling you to specily size and location. Old Bead creates a new bead identical to the last
one created. Open Bead 1s a (little used) alternative to double-clicking. You must have

selected a bead (by single clicking) before use of this command.
The Close All Dialogs command 1s here (well, it had to go somewhere).

All these commands have keyboard equivalents.



Transform

& File Edit Bead ' View Patterns
Reflect...
Resize..

|:| Rotate... VPV
Translate...

These four commands, with the relevant dialog boxes, provide a comprehensive set of tools

for manipulation of models. They do exactly what their names say they do.

View

Edit Bead Transform : Patterns Help
5etScales.. th
foom In [ it

———— ZoomOut  ¥] |
- : . Show Window Info [

Untitled1:¥~Z
Untitled1: X
Untitled1: XY

The Set Scales option allows you to set the relationship between the bead dimensions (in A)
and the scale within the document, as printed at 100%. The Zoom options are self-defining
(and have keyboard alternatives). The Show Window Info command is so useful to remind
you as to which axis goes in which direction that it i1s generally advantageous to keep it

‘switched on’ all the time (standard convention — it’s ‘on” when it’s ticked).

The use of the three commands to view the individual principal planes is useful to avoid

‘clicking around” on the screen.

Patterns

Edit Bead Transform Yiew §; : Help
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This Menu enables you to allocate a distinctive pattern to any bead or set of beads. Simply
select the beads to which you wish to allocate a pattern, and then select the desired pattern

from this Menu.

You can, if you wish, make this palette into a ‘floating palette’. Simply ‘grab’ the palette by
one of its patterns (in the example shown above, the top left pattern has been ‘grabbed’) and

drag it to where you would like it to be:

In the examples shown above, all beads have been selected and filled in with pattern white
(LEFT) whilst on the RIGHT we seen the result of successively selecting two of the beads

and giving them an individual pattern.

This option is useful for identifying individual parts (e.g. those denoting protein domains)

within a total structure.
Help

This is the standard Apple Balloon Help command — it does not contain any MacBeads

specific options.



Output

Models may be saved using the File Menu in the normal manner. The ultimate output for
further interpretation is obtained using the Save as Text command from the File Menu. This
produces a text file which can be opened and if need be edited in any application (MS-
WORD, whatever) capable of handling text.

You can also OPEN the text output within EXCEL, specifying that it is comma delimited

(see the technical notes below). This is obviously useful for sundry further manipulations.

The output (in MS-WORD) looks like this

'rial'’
ZE
1. 152 2., cl.6.; o_o. lo._n
2. 1737, 15.1; o_o,; lz.5
2. Zol.4., l1a._3., a_o, 15._0
g, P 15 5. o_o. lo._n
L 136 .2, a0 _9. o_o. lo._n
[ 1555, S9._7. o_o. lz._5
7. 175.9, a0 .3, o_o. 150
[ 137.7, Qz_.1; o_o,; lo._0
9. 1zs.0, z22.6, a_o, 15._0
1o, 3.5, 12 2. o_o. 150
11. g3 3. -T2, o_o. 150
1z, T1.6. 2.1, o_o. 150
1z, -69.32, -35 .2, o_o. 150
13, -31.2,; -25.0, o_o,; ls.0
15, =12.0, -27.7, a_o, 15._0
16, 15 2. -17.5, o_o. 150
17. -Z25.5, =1lo032_7. o_o. 150
15, -zlo.z, -93_5, o_o. 150
17, -97.5,; -55.3, o_o. 150
ol 1 -1l25.7, —65.7T, o_o,; ls.0
z1. -1sz.1, -59.Z, a_o, 15._0
2E . -1l52.9., -72.0, o_o. 150

<= n-

<z n-

'Crame>!

<ud

<molecunl ar weight>
<partial specific wolume>
1.0=-03

The file starts with the name of the model and the number of beads, and then for each beads

lists the 3 coordinates followed by the radius. The “tailpiece’ information is appended.
Getting started

A simple demonstration file is attached, as well as a copy of the myosin S1 model. Have a go

with these, as well as trying to set up a basic model from scratch.



Some additional technical details

These are some programmer’s notes which take some of the issues raised above a little

further, and may be helpful to users.
Output Format

MacBeads creates a text file output suitable for submission to a particular computer package.

It should be only a small job to modify these files for other end-software ..

The most likely problem is the end-of-line character. The Macintosh convention is to
terminate lines with a return character (ASCII 13) and this is the convention followed.
Another commonly used convention (used by UNIX and MS-DOS amongst others) is to
terminate lines with a linefeed character (ASCII 10). You can use a search-and-replace
facility like Word’s to exchange things round. You just may need to modify the separator

between items on a single line.
Shift-Clicking:

Shift-clicking an unselected bead selects it without otherwise changing the current selection.
Shift-clicking a selected bead deselects it without otherwise changing the current selection.

Shift-clicking an open bead has no effect.
Double-Clicking

Double-clicking an unselected bead clears the current selection and then opens the bead.
Double-clicking a selected bead opens the entire selection, not just the bead. Double-clicking

an already open bead brings the bead’s associated dialog to the front.
Marqueeing

Marqueeing clears the current selection and then selects all beads completely enclosed by the

marquee rectangle. Open beads are unaffected.
Shift-Marqueeing

Shift-marqueeing selects all unselected beads completely enclosed by the marquee rectangle
and deselects all selected beads completely enclosed by the marquee rectangle. The current

selection is otherwise unaffected. Open beads are unaffected.



Dragging (or Shift-Dragging)

This moves the entire selection around. The movement 1s constrained to a plane determined

by the currently active window.
File Menu
Most of the commands 1n this menu work as you would expect. The only things to note are:

The Open command allows you to open both text files and files in the native MacBeads
format . Naturally although you can attempt to open any text file, only those that contain the
correct information will open successfully. Text files created by MacBeads (via the ‘Save As

Text” command) will open correctly but this may not be the case for other TRV files.
Edit Menu
Again these commands mostly work as you would expect. The exceptions are:

Having cut or copied some beads they can be pasted back into the MacBeads document, into
any other MacBeads document or into a document of any other application that can work
with the PICT format. If you paste into a MacBeads document, you are prompted for the
location in three dimensions at which you want the new beads pasted. Only one paste dialog
can be open at any time. If you paste into any other document all you get is a two
dimensional image of the beads (editable in Appleworks PT etc.), the projection being

determined by the active window when the beads were Cut/Copied.

The ‘Set Tailpiece’ command allows you to enter a string that will be appended to all output
text files. The string can include return characters. Clicking on OK in the dialog sets the
tailpiece of the active document. Clicking on Set Default sets the tailpiece for all new

documents you may subsequently create.
Bead Menu

The ‘Open Bead” command creates a modeless dialog showing the coordinates and radius of
the bead that you open. These values may be edited. If the dialog is closed via ‘OK’ the
bead’s settings are changed to the new value. If the dialog 1s cancelled the bead’s settings are

unchanged.

MacBeads makes extensive use of modeless dialogs, so a careless user might lose track of
open dialogs. The ‘Close All Dialogs’ is a quick way of cleaning up by effectively cancelling

all currently open dialogs.
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Transform Menu

This menu provides commands that apply geometric transformations to the current selection.
All dialogs are modeless. Opening a new transformation dialog when one 1s already open
cancels the older one. The transformations are applied to the beads that are selected when the
dialog is confirmed. Most transtormations (Reflect, Rotate and sometimes Resize) take
place with reference to some point. This point is always taken to be the centre of the
selection. Centre here means the geometric centre of the cuboid that exactly encloses the
selection. The centre of mass would be nicer but I do not think the CPU time needed to

calculate 1t would be justified.
Reflect reflects the selection in the Xy, yz or zx plane, as specified by the user.

Resize allows the current selection to be transtormed 1n three different ways. Every bead can
have its radius changed by a fixed amount. Every bead can have its radius changed by some
proportion. A dilatation can be applied to the selection as a whole, effectively expanding or

shrinking it.

Rotate rotates the selection by a specified angle about the X, y or z axis.
Translate translates the selection by a specified vector.

Compatibility

Every file on the Macintosh has a ‘signature’. You do not need to worry about the
technicalities, you just need to know that for the Finder to work correctly signatures must be
unique. Normally before releasing software onto an unsuspecting world one is supposed to
register signatures with Apple to ensure their uniqueness. Naturally I haven’t done this so
there 1s a (very small) chance that the signatures I have used will already be used by some
other file on your hard disc. If this happens the Finder will get confused but program should

still function correctly in most respects.
Reference

R I Bayliss, N Errington, O Byron, A Svensson & A J Rowe (1999) “A conformational
spectrum analysis of the morphological states of myosin S1 in the presence of effectors™
Progr Colloid Polym Sc1 113 158-163

Contacts

Professor Arthur Rowe, NCMH-BC, School of Biosciences, University of Nottingham,
Sutton Bonington, LE12 SRD, UK. arthur.rowe @nottingham.ac.uk
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APPENDIX

The use of pro Fit to display 3D bead models generated by MacBEADS 1.0.1

MacBEADS generates bead models using three principal planes for their construction and
visualisation. The powerful transform commands enable any translational or rotational
operation to be performed on either the whole model or on any selected part of the same.
However, it is true that for many purposes it would be advantageous to be able to 'see' the
bead models in a simulated 3-dimensional space, with a facility for mouse-driven
manipulation of the model - as is routine in programs for display of crystallographic

structures.

A simple approach which we have developed is to use the excellent facilities for 3D graphing
provided in the recent issues of pro Fit (QuantumSoft, Ziirich - see p.17) - a widely used and
respected curve-fitting and graphing package. Text files (.txt) generated by MacBEADS can
be opened within pro Fit, and it is then simple to generate rotatable 3-D models using the pro
Fit module Plot 3D DataXY. The models can be rendered artistically using conventional
lighting effects, and individual views can be saved and printed. Movie files, in which the

model is rotated around a defined axis, can also be generated.

MacBEADS 1.0.1 and the pro Fit module Plot 3D DataXY are thus complementary in their
usage. The former is the 'construction kit' with the ability to both generate models de novo
and to modify existing bead models, including those derived from atomic coordinates. The
latter provides a way of checking the models generated, and of presenting the models for

publication and presentation purposes.
Hardware and System Requirements for the pro Fit interface

These are more stringent than for MacBEADS. An Apple G3/G4 is needed, running System
OS 9.x or OS X (in 'Classic' mode). Pro Fit 5.5 or 5.6 is required, with the appropriate
(downloadable) module 3DPlotterGL 1.2 (5.5) or 3DPlotterGL 1.2 (5.6). Note: a download
will give you both versions of the module: retain within the pro Fit Modules folder only the
module version (5.5 or 5.6) which matches your pro Fit software version, as otherwise
problems will arise on boot up. Quantum Soft say that only the 5.6 version is fully supported

- we have ourselves found that 5.5 works fine, however.

It is sensible to have a reasonable amount of free RAM available when performing 3D

operations on large files. Familiarity with the general features of pro Fit is assumed.
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How to open a MacBEADS file within pro Fit

Having launched pro Fit, simply select OPEN from the FILE menu, and select 'all readable

files' in the show menu in the dialog box:

Open: pro Fit

(S for CD-Rom =] E,I [iﬂ.,l @

I Co- RO abel | 9/4/02
Demonstration txt 974702
myosin head txt 974702
] trial jpg 974702
[ |
[+ |
Show: [AII readable files - ]

[ Cancel ]|| Open ll

N 7

Only MacBEADS files which have been saved as text (.txt files) can be opened. The

contents of the MacBEADS .txt file appear in a new pro Fit DATA window.
Formatting data for use within the 'Plot 3D DataXY' module

The 'tailpiece' information is contained within the lower rows of columns 1-3, and this
prevents the recognition of these columns as pure numerical data. Select all the
(X,Y,Z,RADIUS) values, and cut and paste them two (2) columns to the right. Enter the
headings (X,Y,Z,RADIUS), as this will facilitate further operations.

Bead dimensions

[t is annoying, but although the 'Plot 3D DataXY' module provides for correct relative

sizing of the beads, their absolute size is not in the same units as the principal axes. You need

to scale the bead dimensions, and the scaling factor, alas, can vary. Try dividing your bead
dimensions (COLUMN RADIUS) by 125 for starters, using the Calculate menu/Transform

command to create a new column, which you could label RADIUS/125.
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Doing an initial 3D plot

The first time you do it, you will have to use the LOAD MODULE command from the
Customize menu, to select and import the 3DPlotterGL 1.2 (5.x) module. Thereafter it will

appear within the Prog menu, and 1s selected and started from there.

Upon starting the module, a dialog box appears on the screen:

Plot3D Data XY

Window | Demonstration.txt |+ | X [I s
Y (v :]
Z [z 2]
[Singledatﬂpnints :] Point type [Bﬂlls,smnnth :]
] Connected
Line type | Cylinder (coarse) width |[Se-2
Point size [‘d’ariahle :] Point color | Fixed #]
Ax [R/125 :]
Ay [R/125 ¢]
Az [R/125 2]

| Help | | cancel ]|mc't|

Select your columns for plotting, including R/125 to specity the relative bead dimensions.
Other options are recommended to be as shown above. You can try using the variable hue etc

options, instead of Fixed Color, but the results are not easy to predict !

Likewise, you can go for the smoothest available point type - but bear in mind that this
inevitably uses up memory. Now you can hit the OK button, and a 3D graph appears in a new
window. After setting all axes to a common scale (this has to be done manually), the

resulting image is as shown:
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3DPlotterGlL

rove : shift key

[] Vertical Z-axis

1.2.6

zoom : option key

] Spin | Cancel I
i

[+ visible
Color [cvﬂn i]
] textured Set

Plot 1 (#]

[+ Show axes

[+] Show labels

Color [hlﬂck i]

Color | black = I

Use the Edit menu for editing.

So - how did we fix those axes ? Well, whilst this window (above) 1s open, and before we

eventually touch the Done button, a whole range of manipulations can be effected using the

Edit menu:

Customize Windows Hi

E@Eﬂlc Draw Func Prog
= ndo i

P £

Cut EX jonstration.xt
Copy ®C 1 & 1 7
Paste i z R
Clear

Delete Plot... 3DPlotterG
Plot Options... 38T

Color Options... 3EM

Plot3D Function... 3EE

Plot3D Data XY... 3D

Plot3D Data RowCol... 3ER

Axes Options... 3EA

Axis Style..

Camera & lllumination... 3E1

Background Color...

PICT Options...
General Options...

rnove | shift key zoom : option key
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So - its 'Axes Options' that 1s the command needed to set all axes equal. Sadly, there 1s no
global command for this: you have to inspect the range covered by your data, and then set the
range of the three principal axes to be of equal magnitude: e.g. 200 units 1n all cases, with

start point set to encompass the data range.
Other modifications to the plotting style

As you can see from the Edit menu, facilities are available to modify your 3D plot in a whole
range of ways, as long as the plotting window is open. You can vary the degree of "polish' on
the beads, or their specular reflectivity, among other things. Try them out - or for further

details, see the pro Fit Manual or Help Screens.
Saving a 'style'

Having spent a few moments getting the axes right, and setting other controls (e.g.
illumination) to your liking, then you do not want to have to repeat this every time you open
your data and plot it. The 'style' of plotting which you have defined 1s not attached to your

document 1n any way 1n pro Fit, but you can use the File menu to save your settings:

@Edit Calc Dra
ave 35

S5ave As Movie...

Save Style...

Update Style p
Load Style 4
Delete Style 4

The commands are - hopefully - self-evident in what they do.
Putting additional plots into the same window

Plot 3D DataXY is recursive - 1.e. the module can call itselt, as you can see from the Edit
menu on the previous page. So it is easy, whilst the plotting window is still open (do not
press the Done button !) to place multiple plots into one 3D window by having your data
assorted into sets of (X,Y,Z,RADIUS) columns. Using this facility, different parts of the

same model can easily have different colours assigned to them.
Moving the 3D plot in space
The mouse can be used to rotate, translate or zoom - just follow on-screen commands for the

latter two. All you have to do 1s 'grab' the 3D plot with your mouse !
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Getting a 2D image of your final plot

Atter checking the PICT Options in the Edit menu, hitting the Done button results in a file
being generated which is a 2D image of your final plot. Note: this image is irrevocably 2D -

1t cannot be opened as a 3D plot. You have to re-plot (using your saved style) for that.

Making a movie

Once you have the 3D plot as you want it to be, it 1s simple to make a movie in which the
1mage rotates around any specified (principal) axis. The axes remain as you have set them in

space - hence you can see the rotation from any angular viewpoint.

Rotate about [ Z-axis > I

Time for rotation: |Il] seconds

Mumber of frames: | 200

| Cancel I

The values suggested above give a reasonably smooth movement, without generating too
huge a file. The plots always rotates through 360 degrees - it ends up in the starting
orientation. The files generated run in standard movie players(Quicktime etc) and import

readily into Powerpoint 1f so required.

Pro Fit Software
This 1s available for on-line purchase from QuantumSoft:

http://www.quansoft.com/
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